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Abstract - This project concentrates on alloy wheels. The 

alloy is better than the conventional steel wheels in strength and 

durability. It has excellent wear resistance, anticorrosion 

properties, and longer service life as estimated by the stress 

frequency distribution. The alloy wheel is a significant 

structural member of the vehicular suspension system that 

supports the static and dynamic loads encountered during 

vehicle operation. As in the case of an automobile wheel 

maximum load is applied on the alloy wheel. Proper analysis of 

the alloy wheel plays a significant role in the safety of the 

passenger cars. The 3-dimensional models of the wheel are 

designed in modelling software SOLID WORKS, and further, 

it is imported to the ANSYS software. The static condition is 

chosen for the analysis alloy wheel. 
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1. INTRODUCTION 

 
Alloy wheels are automobile (car, motorcycle and truck) 

wheels which are made from an alloy of Aluminium or 

magnesium metals (or sometimes a mixture of both). Alloy 

wheels differ from steel wheels in a number of ways 

• Lighter weight for the same strength. 

• Better conductors of heat. 

• Improved cosmetic appearance. 

Lighter wheels can improve handling by reducing up sprung 

mass, allowing suspension to follow the terrain more closely 

and thus provide more grip, however it’s not always true that 

alloy wheels are lighter than the equivalent size steel wheel. 

Reduction in overall vehicle mass can also help to reduce fuel 

consumption. Better heat conduction can help dissipate heat 

from the brakes, which improves braking performance in more 

demanding driving conditions and reduces the chance of brake 

failure due to overheating. 

 
1.1 Motivation: 

A major concern in analysing practical mechanical structure is 

to reliably identify their dynamic characteristics such as their 

natural frequencies and vibration mode shapes. These vibration 

characteristics are needed in order to achieve effective design 

and control of the vibrations of structural components. 

Components that are manufactured from cast alloys have been 

widely used in the automotive industry because of its 

characteristic of high strength to weight ratio, low cost and 

better fuel consumption. The integrity of the structural 

performance during the vehicle operations is determined 

through the strength of the spot welds in the body of vehicle 

structure. The metal cutting industry is driven by the increasing 

in number of consumers needs for quality metal cutting related 

products (more precise tolerances and better product surface 

roughness) thus causing them to continuously improve quality 

control of metal cutting processes. Optimization of milling is 

very useful to reduce cost and time for machining mould. Now, 

reduction in wheel weight is a major concern in wheel industry. 

The efficiency of machining operation especially milling 

process is determined by the material removal rate, tool wear 

and cycle time. 

 
1.2 Types of Automotive wheels: 

Various type of wheels which are used in today’s automobiles 

• Steel wheels 

• Alloy wheels 

• Forged and cast wheels 

• Split rim wheels 

 
1.3 Steel Wheel 

Steel wheels have been standard on most low-cost vehicles for 

decades and dominated before alloy rims became cheaper to 

produce. Steel – an alloy of iron and carbon – is a harder metal 

than most other wheel materials, but this strength brings with it 

an increase in weight when compared to the likes of 

Aluminium. The basic way in which steel wheels are produced 

means that there is very little flexibility when it comes to design 

or any type of artistic flare. Different sections of a wheel are 

pressed out and then connected to form the entire wheel, ready 

to be used once the welds have been 

sufficiently ground down 

 
1.4 History of an Alloy Wheel: 

Alloy wheels are made from an alloy of Aluminium or 

magnesium. They were first introduced in the 1930s, but 

became more widespread in the 1960s. The main advantage of 

alloy wheels is that they are lighter and stronger than the steel 

wheels, which improves performance and handling. In 

addition, alloy wheels are more durable and less prone to 

corrosion. They are also available in a wider range of styles, 

which allows for greater customization of a vehicle’s 

appearance. Alloy wheels are lighter and stronger than steel 

which makes alloy wheels more durable and better able to 

withstand the forces exerted on a vehicle while driving. The use 

of alloy wheels dates back to the early 1900s, but they did not 
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become widely popular until the 1960s and 1970s. Today, alloy 

wheels are standard on most new cars, and many drivers choose 

to upgrade their steel wheels to alloy wheels for the improved 

performance and appearance they offer. 

 
1.5 Importance of an alloy wheel: 

An alloy wheel is a type of wheel that is made from a mixture 

of metals, rather than just one type of metal. This makes the 

wheel stronger and more durable than a traditional steel wheel, 

and it also allows the wheel to be designed with a more 

aesthetically pleasing appearance. Alloy wheels are important 

because they are typically lighter and stronger than steel 

wheels, which can improve a vehicle’s performance, handling, 

and fuel efficiency. Additionally, alloy wheels are often more 

aesthetically pleasing and can improve the overall appearance 

of a vehicle. 

1.6 Types of wheel rim material: 

Steel and light alloy are the foremost materials used in a wheel 

rim however some composite materials together with glass- 

fibre are being used for special wheels. Various metals can be 

used for the rim. Commonly seen are alloy (magnesium and 

Aluminium), mag (magnesium), Aluminium, and chrome. 

Teflon coatings are sometimes also applied for an extra layer of 

protection. 

1. Wire spoke wheel 

2. Steel disc wheel 

3. Light alloy wheel 

 

1.7 Selection of material: 

Alloy wheels are made of an alloy of Aluminium and 

magnesium, which makes them light and strong. Normal 

wheels are pressed from steel and may bend if it hits some 

undulation hard on the road. You can use tubeless tyres on mag 

alloy wheels, but on regular wheels you have to use tubed tyres. 

The Aluminium alloy wheel usually has better heat 

conductivity, anticorrosive properties and is much lighter than 

the steel wheel making it the best option for passenger vehicles. 

Aluminium alloy wheels are manufactured using casting and 

forging process. Less weight on the wheel creates less stress on 

the tire, and so a balance is created. Aluminium and alloy 

wheels are largely corrosion-resistant, but prone to galvanic 

corrosion. They are available in attractive bare-metal finishes 

because of their anti-corrosive properties which eliminates any 

need for paint. They also enhance performance by manipulating 

handling and suspension and add a brilliant appearance to the 

vehicle. In this project, A356 (A356.0) Aluminium alloy is a 

typical material for aircraft applications. Unlike wrought 

alloys, cast Aluminium has a different designation system. In 

this article, we’ll focus on A356 (A356.0) Aluminium alloy, 

explain what is A356 Aluminium, list its composition, 

properties, tempers, and uses, as well as 6061 vs A356. For 

superior quality A356 Aluminium casting parts, we’re capable 

of Aluminium die casting for a wide range of industries. 

 
1.8 Comparison of materials: 

A356(A356.0) Aluminium Properties – Physical and 

Mechanical Properties of A356 Aluminium. 14 The properties 

of A356.0 Aluminium including 5 variations (tempers), they 

are A356.0-F, A356.0-T6, A356.0-T51, A356.0-T61, and 

A356.0-T71. T6 heat treatment of A356 Aluminium castings 

offers improved hardness and other mechanical properties. 

Here we create a chart that shows some properties of A356.0 

Aluminium in the T51, T6, and T71 temper. 

 

 

 

 
 

1.9 Introduction to Solid works: 

Solid works is one of the products of Solid works Corporation, 

which is powered by Dassault Systems 3D experience platform. 

Solid works mechanical design automation software is a 

feature-based, parametric solid modelling design tool that lets 

designers quickly sketch out ideas, experiment with features 

and dimensions, and produce models and detailed drawings. It 

takes advantage of the easy to learn Windows graphical user 

interface in which designers can use simple drag and drop 

(DD), copy paste functionality same as in the Windows. Many 

of the icons such as print, open, cut and save are also part of the 

Solid works application which is familiar with Windows 

functions. When designing a model using Solid works, you can 

visualize it in three dimensions, the way the model exists once 

it is manufactured. Solid works is structured in three basic 

types: part mode, assembly mode and drawing mode. Part mode 

is the basic building block in this software. For example, you 

must have to create a part before you create assembly. 
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Assembly mode contains parts or other assemblies, called 

subassemblies. 

These three modes are discussed below one by one. 
 

Figure: Sketching and revolving operation 

 
1.10. Basic concepts of Solid works: 

Parts are the basic building blocks in the SOLID WORKS 

software. Assemblies contain parts or other assemblies, called 

subassemblies. A SOLID WORKS model consists of 3D 

geometry that defines its edges, faces, and surfaces. The SOLID 

WORKS software lets you design models quickly and 

precisely. SOLID WORKS models are: 

• Defined by 3D design 17 

• Based on components 

 
3D Design 

SOLID WORKS uses a 3D design approach. As you design a 

part, from the initial sketch to the final result, you create a 3D 

model. From this model, you can create 2D drawings or mate 

components consisting of parts or subassemblies to create 3D 

assemblies. You can also create 2D drawings of 3D assemblies. 

When designing a model using SOLID WORKS, you can 

visualize it in three dimensions, the way the model exists once 

it is manufactured. 

 
Component Based 

One of the most powerful features in the SOLID WORKS 

application is that any change you make to a part is reflected in 

all associated drawings or assemblies. 

 

1.11 Terminology of Solid works: 

These terms appear throughout the SOLID WORKS 

software and documentation. Origin Appears as two blue 

arrows and represents the (0,0,0) coordinate of the model. 

When a sketch is active, a sketch origin appears in red and 

represents the (0,0,0) coordinate of the sketch. You can 

add dimensions and relations to a model origin, but not to 

a sketch origin. 18 Plane Flat construction geometry. You 

can use planes for adding a 2D sketch, section view of a 

model, or a neutral plane in a draft feature, for example. 

Axis Straight line used to create model geometry, 

features, or patterns. You can create an axis in different 

ways, including intersecting two planes. The SOLID 

WORKS application creates temporary axes implicitly 

for every conical or cylindrical face in a model. Face 

Boundaries that help define the shape of a model or a 
surface. A face is a selectable area (planar or nonplanar) 

of a model or surface. For example, a rectangular solid 

has six faces. Edge Location where two or more faces 

intersect and are joined together. You can select edges 

for sketching and dimensioning, for example. Vertex 

Point at which two or more lines or edges intersect. You 

can select vertices for sketching and dimensioning, for 

example. 
 

1.12 Introduction to Ansys Workbench: 

The idea for Ansys was first conceived by John Swanson while 

working at the Westinghouse trinuclear Laboratory in the 

1960s. At the time, engineers performed finite element analysis 

(FEA) by hand. Westinghouse rejected Swanson's idea to 

automate FEA by developing general purpose engineering 

software, so Swanson left the company in 1969 to develop the 

software on his own. He founded Ansys under the name 

Swanson Analysis Systems Inc. (SASI) the next year, working 

out of his farmhouse in Pittsburgh. Swanson developed the 

initial Ansys software on punch-cards and used a mainframe 

computer that was rented by the hour. Westinghouse hired 

Swanson as a consultant, under the condition that any code he 

developed for Westinghouse could also be included in the 

Ansys product line. Westinghouse also became the first Ansys 

user. Ansys develops and markets engineering simulation 

software for use across the product life cycle. Ansys 

Mechanical finite element analysis software is used to simulate 

computer models of structures, electronics, or machine 

components for analysing the strength, toughness, elasticity, 

temperature distribution, electromagnetism, fluid flow, and 

other attributes. Ansys is used to determine how a product will 

function with different specifications, without building test 

products or conducting crash tests. For example, Ansys 

software may simulate how a bridge will hold up after years of 

traffic, how to best process salmon in a cannery to reduce 

waste, or how to design a slide that uses less material without 

sacrificing safety. 

 
What is Ansys Mechanical: 

ANSYS a product of SASI (System Analysis Simulation and 

Integrating). It is a world's leading software which run on 

CAE (computer aided engineering) and FEM (finite 

element methods). It is widely used by 

designers/analysis in industries such as aerospace, 

automotive, manufacturing, nuclear, electronics, 

biomedical, and much more. ANSYS provides simulation 

solution that enables designers to simulate design 

performance directly on the desktop. In this way, it 

provides fast efficient and cost-efficient product 

development from design concept stage to performance 

validation stage of product development cycle. In ANSYS, 

the basics of FEA concepts, modelling and the analysing 

of engineering problem using ANSYS workbench. In 

http://www.ijsrem.com/


          International Journal of Scientific Research in Engineering and Management (IJSREM) 

                         Volume: 07 Issue: 04 | April - 2023                          Impact Factor: 8.176                          ISSN: 2582-3930                                                                                                                                               

 
 

© 2023, IJSREM      | www.ijsrem.com                                                                                                                              |        Page 4 

 

addition, describe of importance tools and concepts 
given whenever required. this following simulation 

streams of ANSYS. 
 

2. LITERATURE REVIEW: 

 
[1] Prasad SatisDivekar, Dr. ThippeswamyEkbotel: In 

this research work the wheel modelling in CAD &analysed 

with Ansys software. In analysing different properties in6 

different materials (Al alloy, Mg alloy, titanium alloy, 

carbon/epoxy, E glass/epoxy, S glass/epoxy). Aluminium alloy 

has better sustainable properties when compared to other alloy 

materials, which has better deformation factors and stress now 

a days Aluminium alloy is widely used because it has good 

Equivalent Elastic Strain and deformation coefficient. But 

composite material has better advantage than aluminium alloy 

material because of its low weight, low deformation factor and 

high stress handling properties T. Siva Prasad et al. This study 

wheel rim is modelled by using modelling software Catia. Catia 

model is imported to Ansys for analysis work. 

 
[2] Sourav Das et al : investigated the aluminium alloy 

by finite element method, emphasis on reduction of mass of 

wheel rim. There is approx. 50% mass reduction of aluminium 

alloy for existing alloy model. The finite element method used 

for optimizing the component by yield stress calculation. The 

test condition taken as radial fatigue condition, where fatigue 

life and stress distribution estimated. The yield stress of alloy 

material estimated up to 90 MPA for safe application. 

 
[3] B. LALUNAYAK et al: In this study the Modelling 

of the different wheel rims(elliptical spokes shape, Hexagon 

shape)is generated in CATIA and this is imported to 

ANSYS(14.5) for processing work. Alloy wheel rim has been 

designed using Catia software, after that static and 31 modal 

analysis is done with different materials (Carbon Fibre, Mg 

Alloy, Al 6061) boundary conditions taking in ANSYS14.5 

Software. Taking boundary conditions on alloy wheel Radial 

load 3240N is applied along the circumference of the wheel 

rims Finally observed results of stress, total deformation, and 

shear stress on different wheel rims and materials and 

compared with each other. Thus, the best design and material 

can be selected for manufacturing of the alloy wheel. AL6061 

with Elliptical spoke shape have subjected to more total 

deformation compared to Remaining materials 2 materials. 

Carbon fibre have less deformation. 

 
[4] M. Swamy, D Suresh Reddy: in this study the 

modelling of alloy wheel is done is SOLID WORKS design 

software by using various structural analysis is carried out in 

ANSYS work branch at two different pressure with four 

different material such as aluminium alloy, Mg alloy, Peek 

material, Peek (20% carbon fibre) material. 

 
[5] J. Stearns: The wheels of an automobile are usually 

made out of steel but due to the increased demand for 

peculiarity and enhanced outlook alloy materials are used for 

the wheels these days. Many researchers have been carried out 

based on enhancing the geometry of the beam, like slightly 

curved beams could employ more behavioural changes and 

increased stiffness and 32 some have done research on the 

structure which concluded bi-directional fabrics could be more 

efficient and some changes can be made because of changes in 

cross section. 

 
3. METHODOLOGY: 

In this project we followed the methodology given in the below, 

first we collected all the related information about the different 

Aluminium alloys and then collecting some of the literature 

review. 

• Problem identification. 

• Selection of material. 

• Creating a 3D model in SOLID WORKS. 

• Analysing the model (Static structural analysis) 

• Comparing the results. 

 
1. Problem identification: The Aluminium alloy 

A356.0T51 used in production of alloy wheels. We done 

modelling of wheel using the other alloy to increase its 

properties. 

2. Selection of material: A356 Aluminium die 

casting alloy has good casting and machining 

performance. often used to manufacture intricate and 

complex Aluminium castings. It provides lightweight, 

pressure tightness and great mechanical properties. 

3. Creating a 3D model in SOLID WORKS: A solid 

model an alloy wheel is modelled using the software 

Solid works using the different commands in Solid 

works. The design specifications are taken as per the our 

reference. 4. Analysing: the model The model created 

using Solid works is imported to the Ansys for the 

analysis. The static structural analysis of alloy wheel is 

done using the commands in Ansys. 

5. Comparing the results: The properties of the alloy 

wheel A356.0-T6 has better properties when compared to 

the alloy A356.0-T51. 

 

4. MODELLING: 

4.1 Modelling of an alloy wheel 
 

Feature based parametric bidirectional associative software It is 

a advanced designing software compared to Auto Cad, and in 

Auto Cad we can complete all the tasks in single window, but 
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in this we have different windows those windows here we call as 

modules, the main Modules in designing are 

1 Part 

2 Assembly 

3 Drawing 

Total 5 sub modules in part they are 

• Sketcher, feature, sheet metal, surface and weld met. Open the 

Solid works by right clicking or double 

• Clicking on the desk top. Select the file and select new then 

you will be getting the three modules 

• Select the front plane. Sketch and draw the profile of the rim 

using the command functions like line, cantered line, use the 

smart dimension option for lines and to measure the angles. • 

Select exit sketch. And u will be entering into features. Here 

you can solidify it. Go to: Insert > surface > Extrude or click 

on the Extrude icon the surface-Extrude menu appears 

Direction 1 is set to blind. When you use the Blind feature, 

you’ll get a solid extrude surface. 

• Draw an axis and use revolve command 

• Draw a line to extrude a disc for the inner side of the wheel. 

• Adding a material for extrusion of the centre axle draw a line 

extrude it using extrude command. 

• Fillet/Round creates a rounded internal or external face on the 

part. You can fillet all edges of a face, selected sets of faces, 

selected edges, or edge loops. • Click Modify > Fillet (or type 

Fillet). 

• . • Filleting the centre line of rim inner side of the wheel rim. 

• EXTRUDED BOSS/BASE: Adding of material normal to a 

sketch drawn in a plane. Go to Tools> Sketch Entities > 

Centre circular elongated slot a sketch which starts at the 

Origin. Select exit sketch. And u will be entering into 

features. Here you can solidify it. 39 Go to: Insert > 

Boss/Base > Extrude or click on the Extrude icon. The Boss-

Extrude menu appears Direction 1 is set to blind. When you 

use the Blind feature, you’ll get a solid extrude. 

• Boss extrusion of wheel mounting surface using commands. 

• FILLET: create a rounded corner between the wheel 

mounting surface and centre line of rim. 

• Cut-Extrude: It is same as extrude. But it removes material 

from an existing solid in a cross section drawn. Draw a sketch 

then use extrudes in surface it. And draw a profile on the 

surface of the solid body. Select the cut with surface tool and 

remove the material. 

• The material removed for making holes to for the wheel 

housing and bolts and nuts to fix it. 

• The chamfer tool creates a bevelled feature on selected edges, 

faces, or a vertex. To create a chamfer: Click Chamfer 

(Features toolbar) or Insert > Features > Chamfer. Under 

Chamfer Parameters, select an item and set parameters. 

• The outer side of the bolt holes are chamfered using chamfer 

command. This done to make the nuts fix without any 

irregularities. 

• Cut-Extrude: It is same as extrude. But it removes material 

from an existing solid in a cross section drawn. Draw a sketch 

then use extrudes in surface it. And draw a profile on the 

surface of the solid body. Select the cut with surface tool and 

remove the material. • The operation is done to cut the 

windows of the wheel. • Create extruded surfaces from 

models that include 2D or 3D faces and knit the extruded 

surfaces to surrounding features. • Click Insert > Surface > 

Extrude. Select a face: To extrude from a 3D face, select a 3D 

face. To extrude from a 2D face, press Alt + select the planar 

face. 

• Thin layer is extruded to the windows of the wheel. 

• Revolve cut step-by-step revolve features involve spinning a 

profile around a fixed point – the Axis of Revolution. This 

Axis can be a sketch line, an existing edge or a previously 

created axis feature. Often it makes sense to use a 

Construction Line, as this line will be ignored when revolving 

the actual profile. • The thin layer of the window of the wheel 

is cut-revolved. 

• FILLET: create a rounded corner to the outer surface window 

and the disc of the wheel. 

• Sketch and revolve to get tyre mounted on the rim. 

 

 

 

 

 
 

Figure: Sketching and revolving operation 

 

5. STRUCTURAL ANALYSIS OF ALLOY WHEEL: 
Static Analysis A static analysis calculates the effects of study 

loading conditions on a structure, which ignoring inertia and 

damping effects such as those caused by time varying loads. A 

static analysis can, however, includes study inertia loads(such 

as gravity and rotational velocity), and time varying loads that 

can be approximated as static equivalent loads (such as the 

static equivalent wind and seismic loads commonly defined in 

many building codes). 

Static analysis is used to determine the displacements, stresses, 

strain, and forces in structures or components caused by loads 

that do not induce significant inertia and damping effects. Study 

loading and resonance conditions are assumed; that is, the loads 

and the structures response are assumed to vary slowly with 

respect to time. 

To calculates the effects of steady loading conditions on a 
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structure, while ignoring inertia and damping effects, such as 

those caused by time-varying loads. A static analysis can, 

however, include steady inertia loads (such as gravity and 

rotational velocity), and time-varying loads that can be 

approximated as static equivalent loads (such as the static 

equivalent wind and seismic loads commonly defined in 

manycan, however, include steady inertia loads (such as gravity 

and rotational velocity), and time-varying loads that can be 

approximated as static equivalent loads (such as the static 

equivalent wind and seismic loads commonly defined in many 

building codes). 

Static analysis is used to determine the displacements, stresses, 

strains, and forces in structures or components caused by loads 

that do not induce significant inertia and damping effects. 

Steady loading and response conditions are assumed; that is, 

the loads and the structure's response are assumed to vary 

slowly with respect to time. Basic steps in this analysis are 

Importing an alloy wheel, Meshing the model by applying 

material properties, Applying the necessary loading and 

boundary conditions, Analysing the model analysis type as 

static. 

 
5.1 ANALYSIS OF A356.0-T6 ALUMINIUM ALLOY 

 

 

 

Figure: Equivalent Stress 

6. Results And Discussion: 
 

 
 

 

 
7. CONCLUSION: 

Model of the wheel rim is generated in SOLID WORKS 

and this is imported to ANSYS for processing work. In static 

loading, the different loads are applied along the circumference 

of the wheel rims for both Aluminium Alloy A356.0-T51 and 

Aluminium Alloy A356.0-T6 and hub circle of wheel rim is 

fixed. 

Aluminium alloy A356.0-T51 wheel rim subjected to more 

deformation when compare to the aluminium alloy A356.0-T6. 

In both cases stress generated is less than the yield strength, 

hence design is safe. In both cases von-mises stress are less than 

ultimate strength. Aluminium alloy A356.0-T6 wheel rim has 

more life when compare to the aluminium alloy A356.0-T51. 

The alternating stress is more in aluminium alloy A356.0-T51 

when compare to the aluminium alloy A356.0-T6. By 

comparing all result we are suggested that Aluminium alloy 

A3560.-T6 is better material than aluminium alloy A356.0-T51 

for designing of alloy wheel. 
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